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Installing EarMaster 
Mac OS X 
1) Insert the CD and wait for the contents to show. 
2) Drag the EarMaster icon over to the “Applications” folder. 
3) Run EarMaster and choose “Activate now” to enter your serial number and 

activate your license. 
 
Windows 
1) Insert the EarMaster CD in your CD-ROM drive. If the setup program does 

not launch automatically, then select “Run” from the Start menu and type 
“d:setup.exe” where “d:” is the letter of the CD drive. 

2) When the installation program has started, you will be asked to enter your 
serial number. The serial number is placed above the CD in the EarMaster 
box or is printed on the top of your license agreement card. 

3) Once the serial number has been validated, the installation begins. Follow the 
on screen instructions to proceed. 

 
EarMaster can handle individual settings and results for an unlimited number of 
users on one computer. The settings and results are stored under the current 
Windows/OS X user. Therefore each user must have their own Windows/OS X 
account (i.e. own username) to do this. 
EarMaster School can, however, also be configured to show a login screen to 
identify the users. Then the users are not required to have their own Windows 
account. This is configured in the Administration window. 
 
To install EarMaster School on a network, please find the Network installation 
guide in the back of this manual.  
 

What can EarMaster do for me? 
Music is really all about hearing! When you play or hear music your ear is used to 
recognize notes, intervals, chords, major / minor tonality, scales, seventh 
chords, dominants, and so forth. Does your ear perceive the difference between, 
for example, major and minor scales? Between a 4th and a 5th? Between a 
mi7(b5) and a dim7 chord? 
 
A Musical Ear is the single most important skill for musicians, but most musicians 
have poor aural skills because they do not practice ear training. Are you one of 
them? 
 
Ear training with EarMaster will help you to: 
 Play the music you intend to play.  
 Understand the music you hear.  
 Hear the music in your head when you read it.  
 Bring together sight and sound.  
 
Ear training develops greater musicality, confidence and enjoyment of music. 
You will experience that a Musical Ear helps you when you play music, sing, 
improvise, compose and transcribe. Ear training with EarMaster will give you a 
better understanding of all the things you are doing with music! 
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Getting started 

Welcome to EarMaster! 
The training wizard will be shown every 
time you run EarMaster. Here you will 
have an overview of the available 
training modes and exercise areas. 
 
Choosing the Training mode 
Basically, you can work with EarMaster 
using two different training modes:  
 
Tutor mode 
With the tutor mode, the exercises are 
controlled by the tutor. You don't need to know how to configure the EarMaster 
exercises. The tutor will do it for you and adjust the difficulty as you progress. 
 
Customized mode 
With the customized mode, you can configure the exercises to do exactly what 
you want. You can define what intervals, chords, rhythm values, etc, you want to 
train with and even create your own customized chords, scales and chord 
progressions. 
 
If you are a beginner or intermediate level musician, you should always choose 
the EarMaster standard tutor. It contains many lessons in each exercise area. 
The EarMaster Jazz tutor is a supplement to the standard tutor and is not for 
beginners. It contains lessons in the exercise areas that are relevant for jazz. 
Interval lessons are, for example, common for both classical and rhythmic 
musicians. Therefore, there are only interval lessons in the standard tutor. 
The entry level in the Jazz tutor is different for each of the exercise areas, so just 
try it out. If you cannot complete the first lesson, then you probably need to 
complete more lessons in the standard tutor first. 
 
If you want to experiment with special settings or you know exactly what you 
need to exercise, you should choose the Customized exercise. 
 
Choosing the exercise area 
What exercise area you should choose depends on your skills and interests. We 
suggest: 
1. Beginners should choose the Interval comparison exercises in the Standard 

tutor.  
2. After having completed a number of interval comparison lessons, you should 

also include the Interval identification, Rhythm imitation, Rhythm reading and 
maybe Melodic dictation. 

3. Later also include Chord identification, Scale identification and Rhythm 
dictation. 

4. Finally, include Chord inversions and Chord progressions. 
You will get the best results if you work with several exercise areas every time 
you use EarMaster. We recommend that you practice at least 5-10 minutes every 
day in each of the areas you are working with. 
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Using the exercises 
 

Working with exercises 
You control the progress of the lesson with the large control buttons at the top of 
the exercise. Using these buttons you can get a new question when you want, 
play the question again, stop the playing and make EarMaster evaluate your 
answer. 
 
In the Exercise settings menu there are a number of options available depending 
on what exercise area you are working with. 
 
When EarMaster has evaluated your answer, the correct answer will be shown 
with a green marking and the wrong answer with a red marking. 
In the result status toolbar at the bottom of the screen you can see the total 
score in percent for this lesson. 
 
To get detailed statistics of your results you can open the Statistics window. Here 
you can compare your current result with stored results from lessons you have 
completed previously. 
 
Related topics: 

Exercise settings (below) 
Answer input 

 

Exercise settings 
In the Exercise settings menu there is a list of 
settings for the active exercise. With those 
settings you can control how the exercise should 
work. Here you can also open the Customized 
exercise setup window and the Tutor editor (only 
in EarMaster School).  
The other options that are available depend on 
the exercise area and on the exercise setup you 
are currently working with. 
Below is a list of all possible options: 
 
Auto new question 
Get a New question automatically after a question has been answered. The delay 
can be set in seconds.  
If you only want an automatic new question after a correct answer, choose the If 
correct answer option. Then, If you answer a question wrong, you have time to 
find out what went wrong before you manually press the New question button. 
There are more options for this in the Program settings.  
 
Auto replay question 
Repeats the question with an interval until it has been answered. The delay 
between each replay can be set in seconds. You can stop the auto replay 
temporarily by clicking the Stop button while the question is being played.  
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Play question limit 
Set how many times the question can be played. This is useful to make a test 
where the question (e.g. an interval) is often only played twice. The Play 
question button is disabled when the question has been played the maximum 
number of times.  
 
Answer time limit 
This limits the available time to answer the question. The time begins to count 
when EarMaster has finished playing the question. In Rhythm reading it is the 
time until you must have begun clapping the answer. This option is useful to 
make a test.  
 
Auto "Show answer" 
Makes EarMaster automatically press the Show answer button when the chosen 
condition is met. "Correct number of tones": The answer will be evaluated 
automatically when the user has entered the same number of tones as in the 
question. "Correct answer": The answer will only be evaluated automatically if it 
is correct. Choosing this option makes answering VERY easy.  
 
Auto "Show rhythm" 
(only available in Rhythm imitation exercises) Automatically shows the rhythm 
on the staff when the question has been answered.  
 
Play lead-in 
Plays a lead-in bar with the metronome before playing the question or playing 
your answer.  
 
Play rhythm with metronome 
Activates the metronome while playing a rhythm or a melody with rhythm.  
 
Clap rhythm with metronome 
Activates the metronome while clapping a rhythm. If it is not checked, you still 
must clap with the correct tempo, but you can begin anytime you want. 
 
Evaluate note length 
Makes EarMaster also evaluate the length of the notes you are clapping. This 
means you must hold the tone as given by its note value. Microphone input is 
not possible when Evaluate note length is activated.  
 
Answer identification 
Specify how EarMaster should interpret your answer. "Absolute": The pitch of the 
tones must be exactly the same as the question. "Any octave": The name of the 
tones must be the same as the question, but they may be transposed to any 
octave. "Relative": You may transpose your answer freely (e.g. if the question 
was the perfect fourth interval C-F, you may enter the tones D-G as the correct 
answer).  
 
Tone naming 
Choose between the standard tone naming and the solfege tone naming (Do-Re-
Mi-...): "Fixed Do" means Do is always C, no matter what key the question is in. 
"Movable Do" means Do is always the root of the key.  
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Play tone on click 
Hear the tones when entering them on the staff, guitar or piano, and when 
clicking on the multiple choice buttons.  
 
Show key signature 
This shows the key signature on the staff.  
 
Show key name 
This shows the name of the key on the staff, but only if Show key signature is 
checked.  
 
Show first tone 
Shows the root tone of the question on the staff, guitar and piano. The root tone 
is the bottom tone if the tones are played simultaneously or else it is the first 
tone. How the tone is inserted depends on the Answer identification option: If 
"Any octave" or "Relative" is chosen, then the tone is only shown temporarily as 
a grayed note and will disappear when the you insert a tone. This is to allow 
answering in another octave.  
 
Tempo 
Quarter notes per minute when playing tones. The basic note value is always a 
quarter note, so if the meter has another basic note value you need to think... In 
exercises that don't contain rhythms (e.g. interval identification), tones are 
always played as quarter notes.  
 
Visible metronome 
This turns on the visible metronome. 
 
Audio Metronome 
This turns on the metronome sound. 
 
Play harmonic/ascending/descending  
When you have answered the question you are allowed to change the way the 
question or your answer is played. This is only for your own evaluation of the 
question and your answer. The setting for the lesson will not be changed so 
changes do not affect the following questions. When you press New question, it 
will be set back to the lesson settings. If you want to change the lesson so new 
questions are played in the way you want, then you must go to the Customized 
exercise setup to change it. 
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Answer input 
There are several ways you can input your 
answer in the note based exercises (intervals, 
chords, etc). 
In the Answer input menu you can choose 
which ones you want to use: 
 

 Staff 
- To enter a tone, press and hold the left 
mouse button. Move the mouse up and down, 
while holding the mouse button. Release the 
button to insert the current tone. 
- To delete a tone, choose the rubber from the note toolbar and click on a note. 
Right-click in the staff to cycle through the available note values and the rubber. 
 

 Strings 
You can choose different tunings, so this instrument can be a guitar, bass, violin, 
cello, banjo and more. 
- To enter a tone, press and hold the left mouse button. Move the mouse around 
on the tablature while holding the mouse button. Release the button to insert the 
current tone. 
- To delete a tone, just right-click on the tone. 
 

 Piano 
The number of visible keys depends on your screen resolution. If your screen 
resolution is less than 1280 pixels wide you will only see a part of the full sized 
piano, but EarMaster will automatically show the octaves around the question. 
A keyhole sign is shown on the center C. 
- To enter a tone, press and hold the left mouse button. Move the mouse around 
on the keyboard while holding the mouse button. Release the button to insert 
the current tone. 
- To delete a tone, just right-click on the tone. 
 

 Multiple-choice 
The fastest way to answer the question is to use the multiple-choice buttons. 
Left-click the button to give it as your answer. Right-click to hear this option and 
see it transcribed on the staff/guitar/piano. Use the <TAB> and <Arrow> keys 
to select a button using the keyboard. Press the <Space> key to click on the 
selected button 
 

 MIDI-in 
With an external MIDI keyboard (or other MIDI instrument) you can input tones 
very quickly or you can tap rhythms on, for example, a digital drum.  
- To enter your answer, press all the tones you want to enter simultaneously on 
the keyboard. This will insert them on the staff/guitar/piano and then you can 
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release the keys. 
- To change your answer, release all keys and then press all the tones you want 
to enter again. 
From the MIDI instrument you can also remote control EarMaster (see the 
“Program settings” section). 
If your MIDI instrument doesn't allow you to hold the needed number of tones 
simultaneously (e.g. Guitar or Wind MIDI controller), then you can enable the 
One-by-one note input option in the Program settings, to make MIDI input 
function in a way similar to the Microphone input. 
 

 Microphone 
The microphone can be used both for pitch and rhythm input.  
In the rhythmic exercises you can clap the rhythm or play it on a drum through a 
microphone. 
In the pitch based exercises (i.e. identification of intervals, chords, etc), 
EarMaster uses Sound2midi to listen to the tones you sing or play in the 
microphone and find out what tone it is. 
- To enter a tone, sing or play it in the microphone. When the correct tone is 
shown on the staff, guitar or piano, tell EarMaster to insert it. This can be done 
in 3 different ways: 
a) Hold the same tone in a couple of seconds (the exact time can be configured 
in the Program settings) 
b) Press the <Ctrl> or <Insert> key on the keyboard 
c) Use the EarMaster MIDI remote control (see Program settings). 
 
Computer keyboard 
You can insert notes in the staff using the computer keyboard. Type the numbers 
1 to 9 on the main keyboard (not the numeric keypad) to add a note of that 
interval above the root tone; hold down the Shift key while typing the numbers 1 
to 9, to add notes below the root tone (descending). 
The "root tone" is the root of the question. In melodic dictation it is the root tone 
of the key. 
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Exercise areas 
 

 Interval Comparison 
EarMaster plays two intervals and you answer which one you think is the greater. 
Choose A with the mouse or on the keyboard, if you think the first interval was 
the greater or B if the second interval was the greater. 
The piano, guitar or staff is used to show the tones after you have answered the 
question. You cannot use it to enter you answer. 
 
The interval comparison exercise does not require any knowledge about notes 
and music theory. Therefore, it is an excellent starting point for beginners. 
 
Related topics: 

Working with exercises  
Customize interval, chords and scale exercises  
Interval theory  

 

    Intervals, Chords and Scales 
The interval, chord and scale identification exercises work much the same way. 
EarMaster plays some tones (an interval, chord or a scale); you answer what you 
think was played. You can learn how to hear an interval in the “Identifying 
intervals” music theory section. 
 
Basically, you can give your answer in two different ways: 
a) give the name of the interval/chord/scale. For example if you think the played 

tones was a perfect fifth interval, press the button called "Perfect fifth" 
b) name the tones that were played, one by one. This can be done using the 

staff, screen guitar, screen piano, an external MIDI keyboard or by 
singing/playing the tones in the microphone. More information can be found 
in the “Answer input” section. 

When you have added all the tones, click the Show answer button to make 
EarMaster evaluate your answer. 
 
Related topics: 

Working with exercises  
Customize interval, chords and scale exercises  
Interval theory  
Chord theory  
Scale and mode theory  
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 Interval singing 
EarMaster plays a tone and asks you to sing or play an interval above or below 
this tone. Example: A tone (D) is being played and EarMaster says: "Sing the 
perfect fifth above D".  
You sing an A into the microphone. 
 
You can also use this exercise to learn to spell intervals. If you answer the 
question using one of the other answer input methods (see the “Answer input” 
section), then this exercise becomes an "Interval spelling" exercise. 
 
Related topics: 

Working with exercises  
Customize interval, chords and scale exercises  
Interval theory   

 

 Chord progressions 
EarMaster plays a chord progression and you answer what you think was played. 
Basically you can give your answer in two different ways: 
 
a) Multiple-choice. For example if you think the played progression was a I-IV-V-
I cadence, press the button called "I-IV-V-I". You must enable Multiple-choice 
from the Answer input menu to do this. 
Your answer will be evaluated as either correct (100%) or wrong (0%). 
 
b) Name each chord that was played (harmonic function and quality), one by 
one.  
- To select a bar for input and play the chord in it, click on the bar on the staff.  
- To change the quality for the selected bar, use the buttons in the Quality panel 
just below the staff. 
- To change the harmonic function for the selected bar, use the piano or guitar. 
The harmonic functions of the current key are shown on the piano and guitar. 
Click on a tone to insert this harmonic function in the selected bar. Right-click on 
a tone to remove the chord. 
- You can use a MIDI instrument to insert a chord. The bottom tone you play is 
identified as the root and from the rest of the tones you play, EarMaster finds the 
harmonic function (chord) that has the closest match. For example to insert an F 
minor chord, play the tones F and Ab simultaneously. To make it a Fm7, also 
play the tone Eb above (the seventh in a F chord). 
- When you have completed all the bars, click the Show answer button to make 
EarMaster evaluate your answer. 
Your answer will be evaluated as a score between 0% and 100% based on how 
many of the harmonic functions and qualities were correct. 
 
Related topics: 

Working with exercises 
Customize interval, chords and scale exercises 
Chord progression theory 
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 Melodic dictation 
EarMaster plays a melodic phrase and you transcribe what you think was played. 
 
Choose a note value from the note toolbar, the Notes menu or using a keyboard 
shortcut. Then insert the note with a click in the staff, or use the screen guitar, 
screen piano, MIDI or sing the tone in the microphone. More information about 
input methods can be found in the “Answer input” section. Some lessons do not 
include rhythmic evaluation. In this case, all the note values will be disabled 
except the whole note. 
 
When you have added all the tones, click the Show answer button to make 
EarMaster evaluate your answer. 
 
Related topics: 

Working with exercises 
Customize melodic dictation 

 

  Rhythm reading and imitation 
Rhythm reading: EarMaster shows a rhythmic score and you clap the rhythm 
(clap what you read). 
Rhythm imitation: EarMaster plays a rhythm that you must remember and 
repeat (clap what you hear). After the first attempt you can choose to view the 
rhythm score to support you in a second attempt. 
 
You can clap the rhythm in several ways: 
 Tap the rhythm on the spacebar or the Ctrl key 
 Play it on a MIDI instrument  
 Clap it into the microphone  
MIDI and microphone input is activated from the Answer input menu. 
 
While you clap the rhythm, EarMaster will transcribe all your claps in the score 
using green ticks. The ticks are placed relative to the notes in the score to show 
the exact timing of your claps. Then you can easily see how close you hit the 
notes. 
 
If the clap sound is delayed, see the FAQ in the back of the manual. 
 
When you have clapped all the bars, EarMaster will evaluate your answer. The 
ticks will change color. The ticks for claps that were used in the evaluation turn 
green and the ticks for claps that were not found to fit any note, turn red. Below 
each note, EarMaster will show the result of the evaluation. A sign will show how 
you hit the note: 
 
         Correct 
         Too early 
         Too late 
         Not hit at all 
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Related topics: 
Working with exercises 
Customize rhythm exercises  

 

 Rhythm dictation 
EarMaster plays a rhythm and you transcribe what you think was played. 
 
Choose a note value from the note toolbar, the Notes menu or using a keyboard 
shortcut. Click on a bar where you want the note to be inserted. 
 
When you have filled out all the bars, click on Show rhythm to make EarMaster 
evaluate your answer. 
 
Related topics: 

Working with exercises 
Customize rhythm exercises  

 

 Rhythm correction 
EarMaster shows a rhythmic score and plays the same rhythm but with a few 
changes (inlaid errors). You identify the notes with errors and mark them in the 
staff. 
 
Two different types of changes can be made: 
 A note is removed 
 A note is divided into two notes 
 
Click on the staff to mark the notes that are changed. 
 
When you have marked all the notes that were changed, click the Show errors 
button to make EarMaster evaluate your answer. 
 
Related topics: 

Working with exercises 
Customize rhythm exercises  
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Customize the exercises 
 

 Customize interval, chords and scale exercises 
In the list of intervals, chords or scales, click to check those that should be 
included in the exercise. You can also add your own custom chords and scales 
(see the “Edit chords or scales” section). 
 
Playing  
Choose how the question is played: Harmonic, Ascending or Descending. If you 
select more than one, EarMaster will choose among them randomly for each 
question. 
 
Keys and Root movement 
Choose how the questions are transposed. If you have specific needs for keys, 
tone range and position within the key, choose the Advanced option and click 
Edit. 
 
Options 
Play tonic: Play some tones before each question to establish the key of the 
question. Use this option if the question tones must be identified relative to the 
key, for example when using the moveable-do solfege tone naming. 

Common tone (only in Interval comparison): If enabled, the two question 
intervals will have the same root tone. If the intervals are played melodic down 
they will have the top tone in common, otherwise the bottom tone. 

Add deep root tone (only in Chord progressions): Double the root tones of the 
chords to add a bass line. 

Remove 5th in Dom7 chords (only in Chord progressions): In complex jazz 
chords it is common practise to remove the 5th in dominant 7 chords. 

Inversions 
In Chord identification:  Choose Root position to only include the chords as they 
are defined. Choose Closed voicing or Open voicing to allow the chord to be 
played in any possible combination (inversion) of closed voicing or open voicing 
respectively. 
In Chord progressions, choose how the chords are inverted: 
All chords in root position, Last chord in root position or Random inversion of last 
chord. 
With the last two options, the preceding chords will be inverted to a position with 
the top tone closest to the top tone of the last chord. 
There are more options described in the “Exercise control settings” section. 
 
Related topics: 

Interval comparison 
Identification of Intervals, Chords and Scales 
Interval singing 
Chord progressions  
Edit Chords and Scales 
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 Customize rhythm exercises 
EarMaster makes random rhythms using an intelligent algorithm. Select what 
note values that are allowed, then EarMaster will make a rhythm by combining 
these note values in all possible ways. 
 
Special patterns 
To control more precisely how specific note values will appear in the rhythm you 
can use the special patterns. For example you can choose that the 16th notes 
(semiquaver) will always appear in groups of four which is much easier than 
allowing the 16th notes (semiquaver) to stand alone with other note values. 
 
Rests 
Include rests in the rhythm. EarMaster will only make rests of the note values 
that are selected. 
 
Ties  
Allow notes to be tied together across bar lines and across beat groups. 
 
Time signature 
Choose the time signature for the rhythm. You can select more than one. Then 
EarMaster will choose randomly among the selected time signature for every new 
question. With more complex rhythms you should only combine time signatures 
that are similar, because the note values you select are used for all selected time 
signatures.  
For example combining 4/4 with 6/8 is not a good idea because in 6/8 you would 
mainly use dotted notes and the special pattern with three 8th notes (quaver), 
which are not very common in 4/4. 
 
Options 
Set the length of the rhythm (number of bars), the tempo and choose if it should 
be played with swing feeling. For the Rhythm correction exercise you can also set 
the number of changes that should be made in the rhythm. 
If the user should not be allowed to change the tempo while exercising, you can 
choose this in the Exercise control settings. 
 
Evaluation 
Choose how EarMaster should evaluate the rhythm you have clapped. This is 
used when calculating the score. 
 
There are more options described in the “Exercise control settings” section. 
 
Related topics: 

Rhythm reading and imitation 
Rhythm dictation 
Rhythm correction 
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 Customize Melodic dictation 
EarMaster makes melodies using an intelligent algorithm. With the options in the 
exercise setup, you can control how the melodies are made: 
 
Tones (bars) 
Set the length of the melody. If Rhythms are enabled then you set the number of 
bars, otherwise it is the number of tones. 
 
Scale/progression 
The melody will be made of the tones in the scale you select here. All scales 
defined in the Scale identification exercise are listed here, also the user defined 
scales. By making your own custom scale you can control exactly what tones in 
the key that are used. Use the Add custom scale button as a shortcut to create a 
new user defined scale in the scale definition list. 
 
Max. interval  
Set the maximum interval between adjacent tones. 
 
Ambit  
Set the maximum allowed interval from the lowest tone in the melody to the 
highest tone in the melody. 
 
Rhythms 
Make the melody with note values, and also evaluate the note values when you 
answer the question. A correct note value counts as much as a correct pitch in 
the total score. Example: If you answer all pitches correct but none of the note 
values are correct, then your score will be 50%. 
Select what note values that are allowed, then EarMaster will make a rhythm by 
combining these note values in all possible ways. Read more about how 
EarMaster makes rhythms, in the “Customize rhythm exercises” section. 
 
Keys and Root movement 
Choose how the questions are transposed.  
If you have specific needs for keys, tone range and position within the key, 
choose the Advanced option and click Edit. 
 
Options 
Play tonic. If enabled, EarMaster will play some tones before each question to 
establish the key of the question. Use this option if the question tones must be 
identified relative to the key, for example when using the moveable-do solfege 
tone naming. 
 
There are more options described in the “Exercise control settings” section. 
 
Related topics: 

Melodic dictation 
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Keys and root movement - advanced 

Key 
Select if you want to choose specific keys or specific root tones.  
Specific key: EarMaster first chooses the key, then it places the interval or 
chord in the key as you have chosen in the Chord root setting (see below). 
Specific root tone: EarMaster chooses the pitch of the root tone from your 
setting here and afterwards finds the key that fits. The Chord inversion exercise 
works differently. Here you set the bottom tone (not the root tone) so all 
inversions will be played at the same pitch. 
 
Decide how EarMaster should choose among the selected keys or root tones. This 
can either be complete random or cyclic using the 5th circle. 
 
Chord root 
Choose how the interval, chord or scale should be placed in the key. Select what 
scale steps the root can be placed on: 
All tones: All 12 chromatic tones in an octave. 
Scale tones: The diatonic scale tones. 
Step 1-4-5: The basic tonal cadence steps. 
Diatonic interval: The scale steps where ALL of the first 2 or 3 tones in the 
interval/chord fits on a diatonic scale tone. For example, a minor triad will only 
be placed on step II, III and VI. 
Root of key: Always place the root of the interval/chord on the root of the key. 
 
Related topics: 

Customize interval, chords and scale exercises 
Customize Melodic dictation 

 

Edit chords or scales 
You can define your own custom chords, scales and chord progressions, to be 
used in the exercises. Right-click in the list of chords or scales to get a menu of 
options. You can Play, Edit or Delete the selected chord, and you can add a New 
custom chord. 
 
Input tones on the staff, piano or guitar in the same way as in the exercises. 
The chord or scale must be entered as it would look like in the key of C (i.e. no 
fixed sharps and flats, but accidentals are allowed). When EarMaster generates 
questions it will transpose the chord to other keys, but the diatonic definition you 
have made here will be kept.  
Example: if you have defined the tones C-Gb (or I-bV in chord 
progressions) and it is transposed to have Ab as the root tone, then 
the tones will be Ab-Ebb (which is the correct theoretical notation) 
and not Ab-D. 
 
The customized list of chords and scales is shared among all users, so be careful 
when you delete or modify items on the list. They could be used by other users.  
A tutor has its own list of defined chords and scales. When you create a new 
tutor in the tutor editor, the existing list of defined chords and scales on your 
system is copied. All modifications you make to the list in the tutor editor will 
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only apply for the tutor you are working with. The list is however shared among 
all lessons in the tutor, so again be careful when you delete or modify items on 
the list. 
 
Related topics: 

Customize Interval, Chords and Scale exercises 
 

Exercise control settings 
The Exercise control settings window is available through a button in the exercise 
setup window. It is only available in EarMaster School. 
When using the EarMaster exercises there are many options available in the 
Exercise settings menu and the Answer input menu. Most of these options 
influence how difficult it is to answer the questions. If you create lessons for 
other people, then you might want to control some of these options. This way 
you can avoid that users make shortcuts or cheat to get a better score. With the 
Exercise control settings you can force specific settings in the Exercise settings 
and Answer input menus.  
 
Read the chapters “Exercise settings” and “Answer input” in this manual to get a 
description of each option. 
 
The default setting for all the options is User may choose, which allows the user 
to change this option when doing an exercise. You can set any of the options you 
want to a specific behavior. When you do this, the user can no longer change this 
setting when doing the exercise. 
 
Examples 
1) If the user has control of the Auto Show answer option, then it is very easy to 
cheat. The user just needs to set it to Correct answer then all questions can be 
answered correctly without knowing anything about what was actually played. 
Therefore, you should set this option to Disabled if you want to evaluate the 
results from the users of the lesson. 
 
2) It can be a problem having the Play tone on click option enabled. This option 
enables sound when entering tones e.g. in the staff or when right-clicking the 
multiple-choice buttons. For example, if the user should identify an interval 
played melodic up, the user just drags tones up and down the staff to find two 
tones that sound exactly like the tones in the question, without knowing what 
interval was played. This is simple pitch matching which is much easier than 
identifying the actual interval being played. 
 
Related topics: 

Customize interval, chords and scale exercises 
Customize rhythm exercises 
Customize melodic dictation 
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Results 
 

 High score 
The high score window shows the score for all users that have been working with 
the currently selected tutor. 
 
How the points are calculated 
Each lesson in the tutor has points you can earn. Your score in the lesson is 
multiplied with the maximum possible points for the lesson. For example, if your 
score is 75% and the lesson has 20 points, then you will get 15 points for having 
completed this lesson.  
  
Your score is the sum of points you have received from each lesson in the 
selected exercise area. If the Overal high score is chosen, then the score is the 
total sum of all points you have received in all exercise areas. 
 
EarMaster only remembers the best result in each lesson. If you did not get 
maximum points the first time in a lesson, then you can always go back and try 
to get more points. 
 
The results shown in the Statistics window are stored independently of the high 
score. These results can therefore be deleted without affecting the high score. 
 
Related topics: 

Statistics  
 

 Statistics 
In the Statistics window you can view your result together with all historical 
results from the selected exercise area, and easily follow your progress. 
 
When are the results saved? 
Every time you finish a lesson, the result will be saved and will be shown here as 
a new line in the list. If you work with a customized exercise setup then the 
result will only be saved if you have answered at least 5 questions and you are 
always asked first if you want to save.  
If you work with the tutor, the result is always saved, no matter how many 
questions you have answered. 
 
Description of columns 
In the window there are several columns with information about the result and 
the lesson it comes from. Most of these can be shown and hidden from the 
toolbar and from the View menu. 
Date: The date where the lesson was started. 
Time: The time when the lesson was started. 
Tutor: The tutor that the lesson belongs to. 
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Lesson number and title: The number in the list of lessons for this exercise 
area. 
Attempts: Number of times the user has completed the lesson (only visible 
when the Show all attempts option is unchecked, see description below). 
Duration: The time spent on the lesson (only this attempt). 
Answer time: The time spent on answering the questions. This is the sum for 
all questions in the lesson, of the time from the question was played/shown until 
it was answered. 
Total result: Total score for all the questions in the lesson. The number of 
questions that was answered correctly is shown (if applicable), and the total 
number of questions that was answered. 
Details: The score for each of the intervals, chords or scales that is included in 
the lesson. 
Detailed numbers: Show the number of questions and number of correct 
answers for each interval, chord or scale. 
 
Description of View menu options 
In the View menu there are several options to control what users and results to 
be shown and control how they are shown. 
 
Users  
Choose what group of users that should be shown in the list of users: All users, 
All students, All teachers, Users not in a class, or choose a specific class. These 
options are only available in EarMaster School. 
 
Results  
Show all attempts: Shows all results, or else EarMaster will group results for the 
same lesson together and only show the best result for this lesson. Instead it will 
show the number of attempts, which is the total number of times this lesson has 
been started and a result was saved.  
Only tutor results: if checked, all results from customized exercise setups will be 
hidden. The list will then only contain results from tutor lessons.  
 
Result summations 
Choose a period for the result summation calculation. The summation panel at 
the bottom of the results window shows statistics for the selected period of time:  
Duration sum: The sum of the Duration column for the chosen time period. 
Average answer time: The sum of the Answer time column divided with the total 
number of questions. This is the average answer time for one question.  
Total result sum: The sum of the Total result column for the chosen time period. 
 
Related topics: 

High score 
Export results 

 

  Export 
Use the import and export functions to transfer results and settings from one 
computer to another.  
The teacher can, for example, assign a tutor and lessons to a student and export 
this by email to be imported on the student's home computer. When the student 
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has completed the lessons at home, the results can be exported by email back to 
be imported on the teacher's computer. 
Note: EarMaster only exports the tutors that are currently chosen for the user, 
i.e. the tutors that are listed in the "Training wizard" (the welcome window).  
 
In the export window there are the following options: 
 
User data to export 
Assignments 
Include the tutor and the lesson numbers to work with next in the exported data. 
When importing the data, you can continue on the new computer, with the 
lessons you were working with on the computer you exported from. If the 
current tutor is not the standard EarMaster tutor, then the tutor file will also be 
included in the exported data.  
 
Results 
Include the user's results in the exported data. 
 
From user 
Choose what user to export. Only teachers in EarMaster School can export users 
other than themselves. 
 
Destination 
Folder 
Choose a drive or directory where the data should be exported to. This can for 
example be a floppy drive, a flash disk or on the local hard drive. All data files 
will be packed into one compressed zip file in the destination folder. 
 
Attach to email 
Create a new email with the exported data attached. The email address set in 
the user properties for the selected user will be inserted in the To field. The new 
email will be created in the default email reader on the computer (using the MAPI 
interface). 
 
Export 
When you have set the exporting options, click this button to perform the export. 
 
Related topics: 

Statistics 
Import results 

 

Import 
Use the import function to import data that has been exported by EarMaster on 
another computer. The import function is found in the File menu. 
 
To import a data file, just drag it to the import window, then you can see what 
user and what data is included in the file. 
 
The import window contains the following options: 
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Source folder 
Choose the source drive or folder, where the data should be imported from. If 
you drag the data file into the import window, the source folder will be set 
automatically. 
 
Import data 
Assignments 
Import the tutor and the lesson numbers you want to work with next. 
 
Results 
Import the results. The imported results will be merged with the existing results 
on this computer. Result items that already exist will not be imported. 
 
Import to user 
Choose what user the data should be imported to, i.e. the destination of the 
data. Only teachers in EarMaster School can import to other users than 
themselves. 
 
Import 
When you have set the the importing options, click this button to perform the 
import. 
 
Related topics: 

Statistics 
Export results 
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Music theory 
 

Interval theory 
Intervals are the most fundamental part of ear training. All harmonies or 
melodies can be considered as a collection of intervals. As a beginner you should 
therefore begin with Intervals and later continue with, for example, Melody 
dictation to identify a sequence of intervals, or Chord identification to identify 
harmonies with more than two tones. 
An interval is the distance in pitch between two tones. It is labeled by its 
numerical value and its quality. The numerical value indicates the number of 
tones of the diatonic scale it includes. 
 

 
 
In the staff above, the diatonic tones are shown (i.e. the white keys of the piano) 
and they are numbered after their position in the C-major scale. C=1, D=2, E=3 
etc.  
Examples of interval naming: The interval from C (1) to D (2) is a "Second" 
because it includes two tones, the interval from C (1) to E (3) and the interval 
from E (3) to G (5) are both a "Third" because they include three diatonic tones.  
 
Quality 
The quality can be Perfect, Diminished, Augmented, Major, or Minor. 
Unison, fourth, fifth and octave are called perfect intervals. Each of them can be 
diminished (one chromatic tone smaller) or augmented (one chromatic tone 
larger). The rest of the intervals within an octave are: second, third, sixth and 
seventh. Each of them can be major or minor. 
Below is an example of a perfect fifth, diminished fifth and augmented fifth and a 
major and minor third. 
 

 
 
In EarMaster you can hear the intervals in the Interval identification exercise 
when you right-click on the button with the interval name on it. You must enable 
Multiple-choice in the Answer input menu to do this. You can also hear the 
intervals when you right-click on them in the Customized exercise setup, and 
choose play from the menu that appears. 
 
Related topics: 

Identifying intervals  
Intervals exercise 
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Identifying intervals 
A simple way to identify an interval is to connect it with the opening of a well 
known song. For example the song "Amazing grace" begins with a perfect fourth. 
So, when you hear an interval that sounds like the beginning of Amazing grace, 
you know it is a perfect fourth. You can find examples of songs that begin with 
each interval in the “Template melody” section below. 
It is, however, important that you, as soon as you can, try to make the direct 
connection between the interval sound and the interval name - without thinking 
of a melody every time. Because later, when you reach a more advanced level, it 
will be very confusing to mix another melody into the music you are currently 
working with.  
 
Another method to identify intervals is to sing up and down the major-scale to 
find the matching interval. This method is closely related to the solfege system 
(using the syllables do, re, mi, fa, sol, la, ti) which is often used when learning 
sight reading. In the Exercise settings menu you can choose how EarMaster 
should name the tones. Set it to Solfege to use the solfege system. 
 
Template melodies 
Here are examples of melodies that begin with specific intervals. This is only for 
inspiration; you should find your own song that you know well: 
 
 

 Ascending intervals Descending intervals 

Minor 2nd Isn't she lovely (Stevie 
Wonder) 
Nice work if you can get it 

Sophisticated lady 
O little town of Bethlehem 
Major scale (descending) 

Major 2nd Happy birthday 
Strangers in the night 
Major scale (ascending) 

Yesterday (Beatles) 
Satin doll 
M.A.S.H. 
Mary had a little lamb 

Minor 3rd Georgia on my mind 
A foggy day 
Minor triad 

Frosty the snowman 
Hey Jude (Beatles) 

Major 3rd Morning has broken 
Oh, when the Saints 
Major triad 

Summertime 
Giant steps 
Come rain or come shine 

Perfect 4th Amazing grace 
Love me tender 
We wish you a merry 
Christmas 

Oh, come all ye faithful 
Yardbird suite 

Tritone Maria (West side story)  
Perfect 5th Twinkle twinkle little star 

Wise men say (Can't help 
falling in love) 

Feelings 
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Minor 6th When Israel Was In Egypt’s 
Land 
Morning of the carnival 

Love story 

Major 6th It came upon a midnight clear 
NBC theme 

You are a weaver of dreams 
Nobody knows the trouble 
I’ve seen 

Minor 7th Somewhere (West side story) 
Theme from Star trek 

Watermelon man 

Major 7th Cast your fate to the wind 
Theme from Fantasy Island 

 

Octave Somewhere over the Rainbow 
Let it snow 
Blue bossa 

 

 
Related topics: 

Intervals theory  
Intervals exercise 

 

Scale and mode theory 
“Scale” means ladder in Latin. A scale is the tonal basis of music i.e. a set of 
tones from which you build melodies and harmonies. The tones in the list are 
arranged in order of their pitch. Since this tonal basis varies in different periods 
and countries, a large number of scales exist. 
The major scale, minor scale and the church modes are all based on the diatonic 
scale. They consist of the same tones but the center tone (tonic) is different. 
The C major scale looks like this: 

 
 

The Dorian church mode contains the same tones but the root tone is D: 

 
 

In the same way the Phrygian church mode has the root tone E. Lydian has the 
root tone F, Mixolydian has the root tone G, Natural minor (Aeolian) has the root 
tone A and Locrian has the root tone B. 
 
Recognizing scales 
A scale is a sequence of small intervals - usually tones (whole step) and semi-
tones (half step). To identify a scale you need to know the unique sequence for 
this scale. 
Scales based on the diatonic scale will always consist of 5 tones and 2 semi-
tones. Therefore recognizing these scales can be simplified to identify the 
position of the two semitones. 
In EarMaster you can hear the scales in the Scale identification exercise when 
you right-click on the button with the scale name on it. You must enable 
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Multiple-choice in the Answer input menu to do this. You can also hear the scales 
when you right-click on them in the Customized exercise setup, and choose play 
in the menu that appears. 
 
Related topics: 

Scale identification exercise  
 

Chord theory 
A chord is the simultaneous sounding of three or more tones - usually built on 
superposed thirds. Chords are defined by their root note and their quality (major, 
minor, 7, etc) - and eventually by their inversion. 
 
Triads 
A triad is a chord with three notes consisting of a root and the third and fifth 
above it. The most common triads are: 

 Major - has a major third and a perfect fifth 
 Minor - has a minor third and a perfect fifth 
 Diminished - has a minor third and a diminished fifth 
 Augmented - has a major third and an augmented fifth 
On the staff below, the C major, C minor, C diminished and C augmented are 
transcribed: 
 

 
 
Seventh chords 
These chords are triads with still another diatonic third superposed. The most 
common seventh chords are: 

 (Dominant) 7 - is a major triad with a minor 7 added. 
 Minor 7 - is a minor triad with a minor 7 added. 
 Dim 7 - is a diminished triad with a diminished 7 added. 
 Half dim - is a diminished triad with a minor 7 added. 
There are more "triad + 7" combinations than mentioned here. You can find 
them in the chord definition table in the Customized exercise setup of the Chord 
identification exercise. 
 
Inversions 
The original position of a chord with the root note at the bottom is called the root 
position. 
When the third of the chord (e.g. E in a C major triad) is at the bottom it is said 
to be in first inversion. When the fifth of the chord (G in a C major triad) is at the 
bottom it is said to be in second inversion. 
On the staff below, the C major chord is shown in root position, 1. inversion and 
2. inversion: 
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Related topics: 

Chord identification exercise  
Chord progression theory  
Chord progression exercise  

 

Chord progression theory 
A chord progression is a series of chords played in a row. When identifying 
chords within a progression, the main task is to find its harmonic function within 
the key i.e. compare the chord to the tonic which is played before the 
progression. The harmonic functions are written with the Roman numerals I, II, 
III, IV, etc, which denotes the degree within the scale. 
Each of the seven degrees of the major and minor scale can serve as the root of 
a triad. The triads on the “tonal” degrees of the scale, I, IV and V, are the most 
important for establishing the tonality of a piece. 
Below is shown the seven degrees of a C major scale: 
 

 
 
I (C major), II (d minor), III (e minor), IV (F major), V (G major), VI (a minor), 
VII (b dim) 
 
In minor keys, EarMaster always denotes the 3rd, 6th and 7th step as bIII, bVI 
and bVII to avoid confusion because the steps are different. E.g. III is a major 
3rd above the root in a major key while in a minor key it is a minor 3rd above 
the root and therefore it is denoted as bIII. 
To identify chord progressions it is a great help to listen to the bass tone which is 
usually the root of the chord. Notice that several chord progressions can have 
the same root movement but different quality of the chords. You can disable the 
root tone in EarMaster to make it harder for you to recognize it. 
 
Related topics: 

Chord progression exercise  
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For the teacher 
 

Introduction 
(The functionality described in this "For the teacher" section is only available in 
EarMaster School.) 
 
EarMaster is an ideal tool for your ear training teaching. With the tutor editor you 
can make lessons that cover the ear training areas you are currently teaching. 
With your tutor the students are challenged individually based on their 
performance and they receive instant feedback. 
 
You can then focus on the most difficult questions and explain the confusing 
concepts involved. You have access to live statistics on all students' 
performances. These can be detailed statistics for the individual student or a 
broad overview of the whole class. 
 
Students can also do their ear training after class - as homework in the computer 
lab, or you can email the tutor to them so they can work at home. With the 
result exporting facilities the students can email their results back to you from 
their home computer, or bring it on a USB flash drive. 
 
EarMaster School is a motivating and effective teaching tool. Your students will 
get much more practical training of their ears with EarMaster, and it is far more 
motivating than listening to a CD. 
 
Related topics: 

Tutor editor  
Result statistics  
User overview  
Class maintenance  
Export results   

 

 User overview 
In the user overview window you can view a group of users and easily compare 
their results and change their settings. 
All results and statistics apply only to the selected exercise area. In the Exercises 
menu you can choose what exercise area you want the results and statistics to 
be shown for. 
 
Columns and panels 
There are several columns and panels with information about each users settings 
and results. Most of them can be shown and hidden from the toolbar and from 
the View menu. 
Name: The last and first name of the user. 
Last result: Consists of three sub-columns with information about the last 
lesson completed: date, lesson title and result. 
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Summations: The time period can be set from the View menu. The summations 
consist of three sub-columns:  
Duration sum: The sum of the Duration column for the chosen time period. 
Average answer time: The sum of the Answer time column divided with the total 
number of questions. This is the average answer time for one question.  
Total result sum: The sum of the Total result column for the chosen time period. 
Tutor: The tutor that will be loaded by default next time this user opens 
EarMaster. 
Class: Name of the class this user is assigned to. 
Info panel: Panel with information about the user's current settings (properties) 
and the last completed lesson. 
Detailed results: Panel with detailed list of results. It contains exactly the same 
information as the Results window. 

 
View menu options 
In the View menu there are several options to control what users and results you 
see and how you see them. 
Users 
Choose what group of users that should be shown in the list of users: All users, 
All students, All teachers, Users not in a class, or choose a specific class. 
 
Results  
Show all attempts: Shows all results, or else EarMaster will group results for the 
same lesson together and only show the best result for this lesson. It will then 
show the number of attempts, which is the total number times this lesson has 
been started and a result was saved.  
Only tutor results: If checked, all results from customized exercise setups will be 
hidden. The list will then only contain results from tutor lessons.  
 
Result summations 
Choose a period for the result summation calculation. The summation panel at 
the bottom of the results window shows statistics for the selected period of time: 
The summation panel at the bottom of the results window shows statistics for 
the selected period of time:  
Duration sum: The sum of the Duration column for the chosen time period. 
Average answer time: The sum of the Answer time column divided with the total 
number of questions. This is the average answer time (for one answer).  
Total result sum: The sum of the Total result column for the chosen time period.  
 
User management 
In the User menu you have the following options to manage users: 
Assign exercise setup: Choose what custom exercise setup will be loaded by 
default, next time this user opens EarMaster. 
Assign tutor: Choose what tutor will be loaded by default, next time this user 
opens EarMaster. 
New user: Create a new user in EarMaster. 
Properties: Change the properties for the selected user. Here you can set: 
name, username, password, access rights in EarMaster, class and default 
destination email address when exporting from EarMaster. 
Delete results: Delete all results from before a specific date. Only for the 
selected user. 
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Delete user: Delete user from EarMaster including all settings and results. 
To select multiple users, click on the first user you want to select. Press and hold 
the <Shift> key while you click on the last user to select.  
 
If a user is currently using EarMaster on the network, the color of the users 
name will turn green. EarMaster automatically updates the results and statistics 
for the active users. This way you can follow the progress of a whole class of 
students in the computer lab. 
 
Related topics: 

Class maintenance 
 

 Tutor editor 
The tutor editor is available from the Exercise settings menu, but only for 
teachers in EarMaster School. 
 
With the tutor editor you can make series of lessons and save them in one tutor 
file. Other users can easily open your tutor and begin working with the lessons 
you have made. 
A lesson is actually a custom exercise setup where you have added a few extra 
properties like a title, description and some limits that control what result (% 
score) is needed to move on to the next lesson. 
Each exercise area has its own list of lessons. Therefore, you can only control the 
order of the lessons within one exercise area and not how the user jumps among 
the available exercise areas. 
 
To create a new lesson: 
1. Choose the exercise area it should be added to (from the Exercise menu).  
2. Click the New lesson button. 
3. Give the lesson a title on the Properties tab and click Ok. 
4. Now the lesson is created and you can edit the exercise setup to the right of 

the list of lessons. 
 
Here is a description of menu items in the Tutor editor: 
 
File 

Insert tutor 
You can import lessons from another tutor file into the current tutor. This will 
append all the lessons from the chosen tutor to the end of the list. Only lessons 
for the current exercise area will be added. Afterwards, you can delete the 
lessons you did not want imported. 
 

Properties 
Properties for the tutor. Give the tutor a title, a description and enter the name 
of the author of the tutor. The title will be used to represent this tutor in 
EarMaster, i.e. in the list of tutors and every time a new lesson is introduced.  
The description is shown when pressing the Description button in the list of 
tutors (when you open a new tutor). 
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Lesson 
Try lesson in EarMaster 
Find out how the exercise setup you have made for a lesson works in practice. 
When you call this function, the currently selected lesson will be loaded into the 
exercise. 
 
New lesson 
Create a new lesson in the list. 
 
Delete lesson 
Delete the selected lesson. 
 
Properties 
Change the properties for the selected lesson. This is the title, description, 
number of questions, required score to move on to next lesson, the description 
of the lesson and more. Use the on-line help in EarMaster to get a description of 
these options. 
 
Options 
Confirm changes to lessons 
If checked, EarMaster will ask you to confirm when changes to the exercise setup 
are saved in the lesson. 
 
Copy rhythm lessons 
The exercise setup for the rhythm exercise areas is very similar. Therefore, it is 
obvious to reuse lessons made in one rhythmic exercise area in another rhythmic 
exercise area. With this function you can copy all lessons in the current selected 
rhythmic exercise area into another rhythmic exercise area. If the destination 
already contains lesson, the copied lessons will be added to the end of the list. 
 
Export all text to clipboard 
Copies all titles and descriptions from all the lessons in the tutor into the 
clipboard. Then you can paste the text into any other program. This is useful if 
you want the complete overview to review all the text you have written or if you 
want to edit or spell check it in your favourite word processor. 
The text is organized in exercise areas and ordered like in the list of lessons. 
The title of the lesson is the text on the same line as the lesson number   
(e.g. "[-7-] My lesson title"). The following lines until the next lesson number is 
the description of the lesson. Please be careful not to change or delete the text 
inside [ and ].  
The lenght of the lesson title cannot exceed 51 characters. 
When you are done with the text, select it all in your word processor and copy it. 
Then choose the Import all text from clipboard function in EarMaster. If any title 
is more than 51 characters long or any of the identifiers inside the [ ] brackets 
are garbled, then EarMaster will show a warning and not import the text. 
 

 User maintenance 
In the User maintenance window found in the Tools menu, you can add and 
remove users in EarMaster and change their settings. 
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With the default settings, users are created automatically in EarMaster when 
they open it for the first time. They are created as students with default user 
rights. Here you can change their user rights. If the users are not created 
automatically you can add each of them manually in this window. 
 
In the View menu you can choose what users you want to view in the list. 
 
In the User menu you have the following options to manage users: 
Assign exercise setup: Choose what custom exercise setup will be loaded by 
default, next time this user opens EarMaster. 
Assign tutor: Choose what tutor will be loaded by default, next time this user 
opens EarMaster. 
New user: Create a new user in EarMaster. 
Properties: Change the properties for the selected user. See description below.  
Delete results: Delete all results from before a specific date. Only for the 
selected user. 
Delete user: Delete user from EarMaster including all settings and results. 
To select multiple users, click on the first user you want to select. Press and hold 
the <Shift> key while you click on the last user to select.  
 
Related topics: 

User overview 
Class maintenance 

 

 User properties 

User 
Username 
If you have your own user account in Windows/OSX, then you must use this user 
name here. If several users share the same user account in Windows/OSX, then 
you can enter any user name, but it will only work if you also uncheck the Use 
Windows/OSX login option in the Administration settings. 
 
Password 
If you are not worried about security, don't enter any password. Then you only 
have to type your username when you open EarMaster. You should only enter a 
password if you do not have your own account in Windows/OSX. 
 
Access 
Access level 
There are three access levels in EarMaster:  
Administrator: Access to everyting.  
Teacher: Access to everything except the Administration option in the Tools 
menu.  
Student: Limited access depending on the access options below. In addition, the 
student has no access to the tutor editor, and to change settings and to view 
results for other users. 
 
Allow tutor change 
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Allow the user to choose another tutor or another lesson than the one that has 
been assigned to him. If you want to be sure that the user works only with the 
tutor and the lesson you have decided, uncheck this option. 
 
Allow exercise setup 
Allow user to access the custom exercise setup. If not checked, the user can only 
use EarMaster with a tutor. 
 
Allow edit chords 
Allow user to add, edit and delete custom chords and scales. Be careful because 
all users share the same set of customized intervals chords and scales, so one 
user can easily destroy other users work including the teachers work...  
When you un-check this option, the user can still edit chords and scales, but the 
changes are not saved and will be be lost when EarMaster is closed. 
 
Allow private program settings 
Uncheck if EarMaster should not save the program settings for this user account. 
This is useful if you create a user account that should be used by several users. 
Then EarMaster will always load the default program settings set by the 
administrator in the Administration window. 
 
Options 
Class 
Assign the user to a class. You must first create the class in Class maintenance in 
the Tools menu. 
 
Email 
When exporting results or assignments by email, this address will be used by 
default (you can still change it when you send the email). For the home user, 
this could be the address of the teacher that should receive the results. 
 
Private folder 
Specify the location of your private EarMaster folder. The private folder is used to 
load and save files that are only used by you. If you are using EarMaster School 
in a network, please be carefull. The path must work on all computers. It is 
recommended to use the UNC format: \\servername\sharename\path. 
 

Class maintenance 
With a class you can group several users together in EarMaster. This is needed if 
you want to view or print results for several users and don't want to include 
them all. 
 
With Class maintenance found in the Tools menu you can add and remove 
classes. Click New class to create a new class. Then click Add/remove to add 
students to the class. They must first be created as users in EarMaster to appear 
in the list. 
Click Delete class to remove the Class. This will only remove the grouping of the 
users and not delete the users from EarMaster. 
 
See also pt. 6 in the “Network installation” guide. 
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Reference 
 

Program settings 

In the Program settings window found in the Tools menu you can set many 
general settings for EarMaster. 
 
Environment 
Language 
Set the language of all text in EarMaster. It will also set the language of the help 
file and standard tutor. If the help file or standard tutor is not available in the 
new language, EarMaster will use English for those.  
 
Font 
By default, EarMaster will use the font and size defined in Windows for message 
text. If you want to change the font, size or script for EarMaster only, do it here.  
 
Transposing instruments 
If you are using an acoustic instrument with EarMaster, either with microphone 
input or just playing together with the question, set the transposing of your 
instrument here. This setting will transpose all playing and recording all over 
EarMaster.  
 
Rhythm notation 
Specify the spacing between notes. "Fixed space": the space between notes is 
the same no matter what note value they have. This is a very compact notation, 
useful for small screen resolutions. "Time proportional": the spacing between 
notes is proportional with their note values. This also means all bars have the 
same width.  
 
Auto new question 
For exercises where the evaluation is in % and not just correct or wrong, you can 
set when the answer should be considered as correct. This is used for the Auto 
new question function and to choose the sound effect, but it cannot be used to 
improve the result. 
  
Reset all tips 
If you have checked the "Don't show this message again" option when a 
message is shown in EarMaster, this tip or messages will no longer be shown. 
Click this button to make all the messages show again.  
 
Effects/Microphone 
Intro music 
Enable the introduction music when EarMaster starts.  
 
Sound effects 
Enable sound effects, to hear a sound every time you answer a question. Choose 
the volume and a wave file. All wave files in the EarMaster\Media directory will 
appear on the list. Choose (none) to disable a specific sound effect. 
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Auto insert 
If you use the microphone to input tones or use MIDI-in with the "One-by one 
tone input" option checked, then it might be inconvenient to press the <Insert> 
button on the computer keyboard to insert the tones. EarMaster automatically 
inserts the tone if you hold it for a period of time. Here you can set how long 
time you must hold the tone before it is inserted. You can “disable” it by setting 
a high value. 
 
MIDI devices 
MIDI in device 
Choose what device (driver) should be used for MIDI in. If the list is empty, then 
you need to install drivers for your MIDI in device (soundcard or midi interface), 
or maybe it doesn't support MIDI in at all.  
 
Transpose MIDI in 
Set how many semi-tones the MIDI in should be transposed with.  
 
One-by-one tone input 
With the normal EarMaster behavior you must hold all the tones in the answer 
simultaneously. When this option is checked you can input tones one-by-one, 
just like the microphone input.  
Enable this, if you use a wind controller or other midi controller that only plays 
one tone at the time - or if you just prefer to input one tone at the time. 
To delete a tone with MIDI, use Remote control (see below) to activate the Undo 
function. 
 
MIDI out device 
Choose what device (driver) should be used to play MIDI sound. EarMaster uses 
MIDI sound to play all tones and rhythms. If the list is empty then you need to 
install drivers for your sound card or MIDI device.  
 
Synchronize rhythms 
If your sound card has a delay when playing MIDI sound, set it here. Then 
EarMaster can compensate for it. If the delay is unknown, then click the start 
button and adjust the delay until it is synchronized with the flash. 
 
If your sound card has a delay, it is not possible to use MIDI-sound for the clap 
sound from the spacebar. EarMaster then uses a wave file with a clap sound, to 
avoid using the delayed MIDI sound. The wave file setting is available on the 
MIDI instruments tab. 
There is more information in the FAQ in the back of this manual. 
 
MIDI instruments 
EarMaster has six different sound profiles. There is a profile for the piano, the 
guitar, two profile for playing rhythms and two profiles for the metronome.  
One rhythm profile is for a clap sound without sustain and the other one is for 
clap sound with sustain. Only one of the rhythm profiles are visible at the same 
time. Which one is used depends on the setting of Evaluate note length in the 
Exercise settings menu. 
 



 37

For each of the profiles you can set the following: 
Channel 
This is the MIDI channel the tones are sent to. There can only be one instrument 
setting for each channel, so you must have different channels for each profile. 
This does not apply for Channel 10, which is the rhythm channel. Several profiles 
can use it at the same time. 
 
Instrument 
The instrument sound for the profile. This setting is only enabled if the Send 
program change option is checked. The instrument names in the list are from the 
standard GM instrument table. If it doesn't match your sound module you can 
lookup the instrument number in the manual for your sound module. For the 
rhythm and metronome profiles, this setting is disabled when the MIDI channel is 
set to 10 (the rhythm channel). If you want to choose another instrument for 
those profiles, choose a channel other than 10. 
 
Attack 
Set the attack (volume) for the tones in this profile.  
 
Note 
Set the MIDI note number to be played for rhythm claps and the metronome. 
The percussion names in the list are from the standard GM rhythm channel 
instrument table. If it doesn't match your sound module, you can lookup the 
note number in the manual for your sound module.  
 
Wave file 
When there is a delay in the sound card, it is not possible to use MIDI for the 
clap sound on the space bar. Instead EarMaster uses the wave file chosen here. 
The list contains all wave files in the EarMaster\Media directory. Choose (none) 
to disable the sound. 
 
Send Program change 
Changes the instrument sound automatically in the sound module. If not 
checked, you must set the instrument on your sound module manually. This 
option should be checked unless you have special needs, for example a special 
setup of external synthesizers.  
 
Remote control 
MIDI remote control 
You can control several functions in EarMaster with your MIDI instrument. For 
example you can press the large control buttons at the top of each exercise. You 
can also undo the last operation and you can make EarMaster insert the current 
tone when you sing in the microphone or play on your MIDI instrument. 
 
For each remote control function you can define what MIDI message it should 
respond to. This is done by setting the Channel, Type and Value: 
Channel: The MIDI channel EarMaster should listen to. * means all channels. 
Type: Can be set to Tone (note on), Program (instrument/program change) or 
Controller (special MIDI functions, for example the Sustain pedal). 
Value: If Tone is selected for the type you can set exactly what tone it should 
respond to. If Program or Controller is selected, then you set here what program 
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number or controller number it should respond to. 
 
The most common used controller message is the Sustain pedal, which is 
number 64. You can find the complete list in the manual for your sound module 
or on this web page: 
http://www.midi.org/about-midi/table3.shtml 
  
 

EarMaster folders and file types 

Folders used by EarMaster 
There are two default folders defined in EarMaster, a common folder and a 
private folder. In the open and save dialogs there are shortcuts to these default 
folders for easy access: 
 
Common folder 
The Common folder is where teachers should save tutors and customized 
exercises that should be accessable by all users. This folder is a sub-folder to the 
“Shared data files” directory (see below). 
 
Private folder 
The private folder is where the user should save customized exercise setups that 
are private and not should be opened by other users. Each user has his own 
private folder. 
Windows 
In EarMaster Pro, this folder is always  
"C:\Documents and Settings\<username>\<Application data>\EarMaster"  
In EarMaster School the default location is either "<My Documents>\EarMaster" 
or "<Home folder>\EarMaster", depending on what settings the Administrator 
has chosen. The default location can however be overriden for each individual 
user in the user properties. 
Example: "C:\Documents and Settings\<username>\My Documents" 
OS X 
In both EarMaster Pro and School, this folder is <Homefolder>/EarMaster 
 
Shared data files directory 
Here EarMaster stores all the data files i.e. user profiles, settings and results.  
In OS X the default location is "/Users/Shared/EarMaster/5.0" 
In Windows 98 and Windows ME, the default location of the data files is 
"<installation path>\Shared" (Example "c:\Program files\EarMaster Pro 
5\Shared") 
In Windows 2000, XP or newer the default location of the data files is "<Common 
Application data>\EarMaster\5.0" (Example "C:\Documents and Settings\All 
Users\Application Data\EarMaster\5.0") 
 
If you have chosen Server install when installing EarMaster School, the default 
location is a subdirectory to the installation directory. In EarMaster School you 
can change the location of the Shared data files (see the “Administration” 
section). 
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File types used by EarMaster 
*.ear - Customized exercise setup file 
This file contains a setup for all exercise areas in the same file. It does not 
contain customized chords and scales, i.e. it uses those defined in the EarMaster 
program that loads the file. Therefore a *.ear file can only be used on other 
EarMaster installations if it doesn't use customized chords/scales or if they are 
also defined on the new computer at the same positions. 
 
*.tut - Tutor file 
This file can contain any number of lessons for each of the exercise areas. A 
lesson is a Customized exercise setup with a title, description and a few more 
properties added. The tutor file has its own list of customized chords and scales 
(which is defined in the tutor editor) and therefore this file can be used on any 
computer with EarMaster Pro or EarMaster School. 
 
*.his - Highscore file 
The high score file contains a list of users and their points in each of the lessons 
in a tutor. The high score file is always linked to a tutor file and has the same file 
name; only the extension is different. If you make changes to a tutor in the tutor 
editor, EarMaster will automatically delete the associated high score file. 
 
*.da5 - Binary data files 
The EarMaster binary data files are stored in the \Shared\Data directory and 
contain user data, settings, results and more. 
 
*.lan - Language file 
This is a text file that contains all the text in EarMaster, i.e. menus, messages 
and pre-defined chords and scales. If you want to change the terminology used 
by EarMaster, simply open the file with a text editor (Notepad in Windows or 
Textedit in OS X) and edit the text. The language files are in the "Language" sub-
folder to the installation directory. 
 

Export result database 
You can export the EarMaster user list and selected results to a standard data 
interchange format called CSV. This is actually a text file with a standardized 
formatting that allows databases and spreadsheets like Excel to read it. 
 
This is useful if you need to backup results in a format that is readable by any 
program (required by some schools), or you want to make further statistical 
analyses on the results beyond what EarMaster offers. 
 
To export, choose what users, exercise areas and time period you want results 
from. Then choose a destination folder and click Export. This will create the file 
"Users.csv" with a list of all the users that was exported. The fields in the file 
are: Username, Full name, Access and Class. 
 
For each user listed in "Users.csv" it also creates a file "<username>.csv", which 
contains the exported results for this user. The fields in this file are: Date, Time, 
Exercise area, Duration, Tutor, Lesson number, Lesson name, Number of 
questions, percent correct answers and a list of detailed results. 
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Administration 
The Administration window found in the Tools menu is only available in 
EarMaster School and only for users created as Administrators in EarMaster. 
 
Shared data files 
Specify where EarMaster can find the folder with its data files. See the 
“EarMaster Folders and file types” section for a description of the default location 
of this folder. 
Here you can choose another location for the data files, but please follow the 
"How to move the data files" instructions below. 
 
If you run EarMaster from a shared network drive, then changes to this path will 
apply to all computers that load EarMaster from this location.  
The location of the data files is stored together with the program file. Then 
EarMaster can find the data files even when loaded from a server, on a client 
where it is not installed. 
If you run EarMaster from a local drive on the computer then changing the 
shared data path will only apply to this computer. 
A text in the window will inform you about the scope of this change.  
 
How to move the data files: 
1. Copy (not move) the "Shared" folder with all files and subdirectories from the 

current location to the new location. See the “EarMaster Folders and file 
types” section for a description of the default location of this directory. If 
several computers should use the same data files, be sure to place the 
Shared folder on a network drive that is accessible from all computers. 

2. Go to the Administration window (in the Tools menu) and set the new location 
of the data files. If you load EarMaster from a network drive, be sure to give 
the path in a way that works on all computers. The safest way is using the 
UNC format "\\servername\sharename\directory". 

3. Close EarMaster and rename the old shared folder to for example 
"OldShared". 

4. Open EarMaster and verify that everything works and that users and results 
are still there. 

5. Delete the "OldShared" folder. 
 
Private folder 
(this option is only available in Windows) All users have a private EarMaster 
folder where their own customized exercises are stored. Here you can set what 
the default location of the private folder is. See also the “EarMaster Folders and 
file types” section. 
A Home folder is a folder on the network that is yours. The location is set in the 
Windows user profile and is controlled by the Administrator on the network. 
EarMaster will get the location (of the home folder for the current user) from 
Windows. 
If you have specified that EarMaster should use the Home folder, but the 
Windows user does not have a home folder then EarMaster will use "My 
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documents" instead. 
If you use EarMaster in a network without roaming of user profiles then you 
should use the Home folder, or you can set a location in the properties for each 
user in EarMaster. 
 
Options 
Use Windows/OS X login  
Automatically loads the usersettings based on the username of the current 
Windows/OS X user. If not checked, EarMaster will show a login window every 
time it loads.  
 
Auto create new users 
Allows creation of new users in the EarMaster user list when they load EarMaster 
for the first time. If the Use Windows/OS X login option is checked, the user is 
created automatically, if the Use Windows/OS X login option is not checked, 
EarMaster will show an Add new user button in the login window. 
If not checked, new users can only be added in the User maintenance window by 
a teacher or administrator. 
 
Functions 
Save default program settings 
The program settings are saved for each user as records in the 
\Data\Settings.da5 file. When a new user is created, the profile is created with 
the program settings from the default record. If you want new users to get 
specific program settings when they login for the first time, configure EarMaster 
as you want it to be and then press the Save default program settings button. 
The program settings are: 
 All settings listed in the Exercise settings menu  
 All settings shown in the Answer input menu 
 All settings shown in the Program settings window (in the Tools menu) 
 Position and size of windows and toolbars 
 
Delete results 
To reduce the size of the result databases and reduce the network traffic, you 
can delete old results here. All results from before the selected date will be 
deleted. The results are deleted for all users. 
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Appendix 
Network installation 
EarMaster School can be installed and integrated in a network so users can use 
their personal EarMaster profile from any client. EarMaster School can even run 
directly from a server without installation on the clients, but you can also install 
it on the clients to reduce network traffic. Do the following: 

Installing (for the administrator) 
 
Windows: Follow the instructions 1a, 2a and 3 to 6 
OS X: Follow the instructions 1b, 2b and 4 to 6. If you have a smaller and fast 
network, you might want to install EarMaster to run directly from the server, 
without installation on the clients. In that case use step 1a and 2a instead. 
 
1a) Install EarMaster on the server 
Run the installation program and follow the instructions.  
 
Windows only: 

On the page Select Additional Tasks, be sure to set the Destination of 
shared data files setting to Server install.  
This will place the shared data files in a subdirectory to the installation 
directory (can be moved to another location later, see instructions in the 
"Administration" section), and it will install the client setup utility 
(described in step 3). 

 
When you have installed EarMaster on the server you can run the EarMaster 
application directly from the server on any client. When you run EarMaster from 
a shared network drive it will automatically look for the data files in the folder 
from where the program file was called and not on the local computer. 
 
2a) Run EarMaster once from a client computer to configure it 
Make sure you run EarMaster from a shared drive on a client, and not directly on 
the server. This will force EarMaster to load and save the administration settings 
together with the program file on the server and not, as usually, in the registry 
of the local computer. 
 
You are asked if EarMaster should use the Windows/OS X login to identify users.  
If all users have their own login in Windows/OS X - Answer Yes! EarMaster will 
then get this username from Windows/OS X to identify what user settings to 
load. If you answer No, EarMaster will show a login window every time it is 
started. 
 
You are asked to create your self as a user (Administrator) in EarMaster.  
If you answered No in the previous question you must remember the username 
and password entered here because only the Administrator can give other users 
"Teacher" and "Administrator" rights. Do not use your Windows/OS X admin 
password because EarMaster uses only a soft encryption algorithm that is easy to 
break for a skilled hacker. 
If you answered Yes in the previous question then you cannot enter a username 
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and password. Instead EarMaster will attach the new Administrator user to the 
current Windows/OS X user account. 
 
After choosing a MIDI device for this client and a screen instrument for your user 
profile, you can enter the Registration name and serial number for this network 
installation. 
 
Windows only: 

Opening help files from a network drive is not allowed by the security in 
Windows Vista (and latest updates of Windows XP). Therefore the online 
help in EarMaster does not work when it runs from a server. To solve this 
you can install EarMaster on the clients (step 3) or find solutions here: 
support.microsoft.com/kb/896054  
 
Running a program from a network drive gives a security warning in 
Windows Vista asking you to confirm running the file. To avoid this 
warning you can install EarMaster on the clients (step 3) or you can 
change the security settings: 
Go to “Internet options” in the Control panel. On the "Security" tab, add 
the name of the server where EarMaster runs from (e.g. \\MYSERVER) to 
the "Sites" for "Local intranet". Then set the security level for "Local 
intranet" to "medium-low" or if you want a higher level, modify it to a 
custom level with "Launching applications and unsafe files" set to 
"Enable". 

 
Now EarMaster is configured to run on any client! 
 
1b) Install EarMaster on a master-client 
Install EarMaster on a client to prepare a master application bundle. This master 
can be distributed unaltered to all client computers in the network. The master 
client must not be the same computer as the server where the shared data files 
should be placed.  
 
2b) Configure the master-client 
Run EarMaster on the client to create the data files in /Users/Shared/EarMaster. 
You will be asked to create an administrator account in EarMaster. It will be 
connected to your OSX username. If several users share the same account in OS 
X, open "Administration" in the "Tools" menu and disable the "Use OS X login" 
option, this will force EarMaster to show its own login screen everytime it runs. 
 
Copy (not move) the EarMaster folder with the shared data files from 
/Users/Shared/ to the wanted location on the server. 
 
Open the "Administration" settings in the "Tools" menu and set the new location 
of the data files. This settings will be stored inside the application bundle so you 
can distribute the bundle unaltered to all the clients in the network. 
 
Close EarMaster and delete the local EarMaster data folder in /Users/Shared/. 
 
Run EarMaster again and verify that it now uses the shared data on the server (If 
you are asked to create an administrator again or other error messages appears 
about files not found, then EarMaster has not been configured correct).  
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The bundle is now ready to be distributed on the network.  

3) OPTIONAL: install EarMaster on the clients 
To reduce network traffic you can install EarMaster on each client. The program 
files of about 6 MB will then be loaded from the client and not from the server. 
To install EarMaster on a client, run the "ClientSetup.exe" program once on each 
client. The client setup program is in the same folder as the EarMaster program 
file on the server. 

4) Add teachers 
New users are added automatically to EarMaster when they run it for the first 
time (unless you disable this feature in the Administration settings). Users that 
are automatically created when they log in, will however only have student user 
rights to begin with. 
To give the teachers immediate access to the facilities they need to use, you 
should add them as Teachers in EarMaster. If each user have their own account 
in Windows/OS X then you must know their user name to do this. To add a 
teacher: 

1. Find User maintenance in the Tools menu.  
2. Click on the New user button in the toolbar. 
3. Type in the full name and username on the User tab and set the Access level 

on the Access tab to Teacher. 
4. Finally click Add to create the user in EarMaster. 

Repeat these steps until all teachers are created in EarMaster. 
 
Creating students and classes (for the teacher or administrator) 
5) Add students 
Users can be added to EarMaster in two different ways: 
a) Find User maintenance in the Tools menu. Choose New user to create a new 

user. Note: if all users have their own account in Windows/OS X, you must 
know their username to create users this way. 

b) Go to the computer lab with your class and let each student run EarMaster. 
When EarMaster is executed by a user that is not yet created in EarMaster, 
this user is (by default) automatically created.  

6) Create a class 
You are not required to group the students in classes, but it is a very good idea if 
there are many users. When all the users for the class are created in EarMaster, 
do the following: 

1. Find Class maintenance from the Tools menu.  
2. Click the New class button to create a new class.  
3. Give the class a name and click the Add/remove button to add students to 

the class. 
4. In the new window that shows up, select the users that should be added to 

the class and click Add. 
When the year or semester is gone and the name of the class changes to a new 
number, just go to the Class maintenance to change the name of the class. You 
don't need to add the users again. 
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License Agreement for EarMaster Software 

IMPORTANT: This EarMaster License Agreement is a legal agreement 
between you (either an individual or a single entity) and EarMaster ApS 
for the EarMaster software product identified in your license, which 
includes computer software and may include associated media, printed 
materials, and ”online” or electronic documentation - hereafter called 
the (”SOFTWARE PRODUCT”). By installing or otherwise using the 
SOFTWARE PRODUCT, you agree to be bound by the terms of this license 
agreement.  

 
SOFTWARE PRODUCT LICENSE 
The SOFTWARE PRODUCT is protected by copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT 
is licensed, not sold.  
 
1. GRANT OF LICENSE. This license agreement grants you the following rights:  

 Applications Software. You may install and use the SOFTWARE PRODUCT, or in its place, 
any prior version for the same operating system, on as many computers as the number of 
licenses purchased. The primary user of the computer on which the SOFTWARE PRODUCT is 
installed may make a second installation for his or her exclusive use on a portable computer. 

 “Site License”. A “Site License” allows unlimited use of the SOFTWARE PRODUCT at one 
campus/physical entity and allows all employees to install the SOFTWARE PRODUCT on their 
private computer. A “Site License” cannot be held by a private person. It is a license for 
educational institutions, music schools, companies and choirs. 

 “Home User Site License”. A “Home User Site License” allows up to 200 students and 
employees at one campus/physical entity to install one copy of the SOFTWARE PRODUCT on 
their private computer if he/she: 

- has a printed copy of the “Home User Site License” agreement and 
- holds a valid ID that identifies the connection to the institution holding the “Home User Site 
License”. 

A “Home User Site License” cannot be held by a private person. It is a license for educational 
institutions, music schools, companies and choirs. If a "Home User Site License" is held by a 
choir, it allows all choir members to install one copy of the SOFTWARE PRODUCT on a private 
computer. 
Notice! Computers owned by the holder of this license are not covered by this license. If the 
educational institution, music school, company or choir holding this license would like to install 
the SOFTWARE PRODUCT on own computers it will need a separate license for this. 

 Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on 
a storage device such as a network server, used only to install or run the SOFTWARE 
PRODUCT on your other computers over an internal network; however, you must acquire and 
dedicate a license for each separate computer on which the SOFTWARE PRODUCT is 
installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be 
shared or used concurrently on different computers.  

 
2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.  

 Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 
 Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not 

reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT.  
 Software Transfer. You may permanently transfer all of your right under this license 

agreement, provided you retain no copies, you transfer all of the SOFTWARE PRODUCT 
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(including all component parts, media and printed materials, any upgrades and this license 
agreement), and the recipient agrees to the terms of this license agreement. If the SOFTWARE 
PRODUCT is an upgrade, any transfer must include all prior versions of the SOFTWARE 
PRODUCT. 

 Not for Resale Software. If the SOFTWARE PRODUCT is labeled ”Not for Resale” then, 
notwithstanding other sections of this license agreement, you may not resell, or otherwise 
transfer for value, the SOFTWARE PRODUCT. 

 
3. UPGRADES. If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly 
licensed to use a product identified by EarMaster as being eligible for the upgrade in order to use 
the SOFTWARE PRODUCT. A SOFTWARE PRODUCT labeled as an upgrade replaces and/or 
supplements the product that formed the basis for you eligibility for the upgrade. 
 
4. COPYRIGHT. All title and copyrights in and to the SOFTWARE PRODUCT (including but not 
limited to any images, animations, audio, music and text incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials and any copies of the SOFTWARE PRODUCT 
are owned by EarMaster ApS. The SOFTWARE PRODUCT is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other 
copyrighted material except that you may install the SOFTWARE PRODUCT within the limitations 
of this license agreement provided you keep the original solely for backup or archival purposes. 

 
LIMITED WARRANTIES 
LIMITED WARRANTY. Manufacturer warrants that the SOFTWARE PRODUCT will perform 
substantially in accordance with the accompanying user documentation for a period of 90 days from 
the date of receipt. Any implied warranties on the SOFTWARE are limited to 90 days. Some 
jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation may 
not apply to you. 
 
CUSTOMER REMEDIES. Manufacturer’s entire liability and your exclusive remedy shall be, at 
Manufacturer’s option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE PRODUCT that does not meet this Limited Warranty and which is returned to 
Manufacturer or the supplier serving your country with a copy of your receipt. This limited Warranty 
is void if failure of the SOFTWARE PRODUCT has resulted from accident, abuse, or 
misapplication. 
 
NO OTHER WARRANTIES. Manufacturer and its suppliers disclaim all other warranties, either 
express or implied including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to the SOFTWARE PRODUCT, the accompanying product 
manual(s) and written materials. 
 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Manufacturer be liable for 
any other damages whatsoever (including, without limitation, damages for loss of business profits, 
business interruption, loss of business information, or other pecuniary loss) arising out of the use of 
or inability to use this product, even if Manufacturer has been advised of the possibility of such 
damages. In any case, Manufacturer’s entire liability under any provision of this agreement shall be 
limited to the amount actually paid by your for the software. Because some jurisdictions do not allow 
the exclusion or limitation of liability for consequential or incidental damages, the above limitation 
may not apply to you. 
 
Should you have any questions concerning this agreement, or if you desire to contact us for any 
reason, please write to Manufacturer. Manufacturer is: EarMaster ApS, Egaa Havvej 21, DK-8250 
Egaa, Denmark. E-Mail: info@earmaster.com 
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FAQ 
There is no sound 
Go to the Tools menu and choose Program settings. On the Devices tab you can 
choose among different Output-devices. Choose one from the list, set the volume 
to max and click the Play button. If this doesn't produce any sound, try to choose 
another from the list. At least one of them should produce some sound. If there 
are no devices on the list then you need to install drivers for your sound card or 
MIDI interface. 
In some situations it can cause problems if more programs use MIDI at the same 
time. Please try to restart Windows and run EarMaster as the only program using 
MIDI. Please also make sure that the volume (attack) is correct in the sound 
profiles for Chords, Rhythm and Metronome. They are changed on the MIDI 
instruments tab in the EarMaster Program settings. 
 
The sound is not good; the chords are muddy 
EarMaster uses the MIDI sound in your sound card. Some sound cards can 
produce MIDI sound using different technologies, each with its own driver 
installed. Therefore first try to choose another MIDI device from the list in the 
Program settings. 
If the sound is not acceptable, you must buy another sound card. A sound card 
with wave table technology will give you a better sound (see also “The sound is 
delayed” below). 
 
The sound is delayed  
A sound card with Wavetable technology can give you a very good sound quality 
for the MIDI instruments. It is however important that your sound card 
generates its instrument sounds from a hardware Wavetable, not a software 
Wavetable. Software Wavetable sound generation leads to annoying delays 
between pressing the spacebar, and hearing the sound. 
EarMaster can compensate for the delay in your sound card. When you activate 
this compensation, EarMaster will use a wave file for the clap sound to avoid 
using the delayed MIDI sound in your sound card. 
Choose the Tools - Program settings menu item and find the MIDI devices tab. 
Here you can Synchronize rhythms by adjusting the delay. 
If the internal compensation is not acceptable or possible then the only solution 
is to buy another sound card. 
 
MIDI IN does not work  
To make MIDI in work, do the following: 
1) In the EarMaster Program settings, choose the driver that should be used on 
the Devices tab. If no driver is listed then you need to install one that fits your 
sound card or MIDI interface. 
2) Enable the MIDI in from the Answer input menu 
3) Make sure that no other programs are running that use MIDI in. Sometimes 
Windows cannot handle if two programs want to use MIDI in at the same time. 
 
Can I change the terminology (e.g. chord names) used in EarMaster?  
Yes! All text in EarMaster can be changed. The file "English.lan" is a text file and 
contains all the English text strings in EarMaster. You can find the language files 
in the "Language" folder in the installation directory (e.g. c:\program 
files\EarMaster\Language). Just double-click the file to edit it with Notepad. 
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EarMaster keyboard shortcuts 
 
This is a list of the keyboard shortcuts you can use in EarMaster.  
 
Exercise control 
Windows OSX  
F5 or Alt+N F3 New question 
F6 or Alt+P F4 Play/repeat question 
F7 F5 Third button 
F8 F6 Fourth button 
F9 or Alt+S F7 Stop 
Ctrl+F7 F7 Play tonic of key 
Ctrl+Z or Delete Z or Delete Undo 
Ctrl or Insert Ctrl Insert the tone played/sung in the microphone 
*You can also use the TAB and Arrow keys to choose a button. Press <Space> to 
click on the chosen button. 
 
Options and functions 
Windows OSX  
Ctrl+T T Tutor (toggle between Customized exercise and 

tutor) 
F3 F3 Customized exercise setup 
Ctrl+R R Statistics and Results 
Ctrl+H SHIFT H High score 
   
CTRL+O O Open (exercise setup) 
Ctrl+Alt+O ALT O Open (Tutor) 
CTRL+S S Save 
CTRL+P P Print 
F5 F5 Refresh (results or user lists) 
Ctrl+A A Select all (chords or users) 
Ctrl+D D Deselect all chords 
   
F11 F11 Midi In (toggle) 
Ctrl+F11 ALT F11 Midi In remote control (toggle) 
F12 F12 Microphone (toggle) 
Ctrl+F5 F4 Auto new question (toggle) 
Ctrl+F6 F6 Auto replay question (toggle) 
Ctrl+Left/right 
arrow 

 <Left/right 
arrow> 

Chord progressions, move bar cursor 

 
 
Note input 
Windows OSX  
- - Rubber 
NUM 6 NUM 6 Whole note (semibreve) 
NUM 5 NUM 5 Half note (minim) 
NUM 4 NUM 4 Quarter note (crotchet) 
NUM 3 NUM 3 Eights note (quaver) 
NUM 2 NUM 2 Sixteenth note (semiquaver) 



 

NUM 1 NUM 1 32nd note (demisemiquaver) 
NUM 0 NUM 0 Rest toggle 
. . Dotted toggle 
* * Triplet toggle 
/ / Tied toggle 
NUM 7 NUM 7 Flat 
NUM 8 NUM 8 Natural 
NUM 9 NUM 9 Sharp 
   
  Add interval 
1 SHIFT 1 Unison 
2 SHIFT 2 Second above 
  ... 
8 SHIFT 8 Octave above 
9 SHIFT 9 Ninth above 
   
SHIFT+2  2 Second below 
SHIFT+3  3 Third below 
  ... 
SHIFT+8  8 Octave below 
SHIFT+9  9 Ninth below 
 
 
Tutor editor 
Windows OSX  
CTRL+O O Open 
CTRL+S S Save 
Ctrl+L L Lesson properties 
Ctrl+N N New lesson 
CTRL+<Arrow 
up> 

<Arrow 
up> 

Move lesson up 

CTRL+<Arrow 
down> 

<Arrow 
down> 

Move lesson down 
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